Instructions for local and remote access to the Neighborhood Change Database (NCDB) 1970-2000 US Census Tract Data CD

Users of the NCDB who need help or are unsuccessful setting up a connection to the NCDB CD, should contact Data Archive and Data Support at psc-dads@umich.edu or 734-763-2163.

NOTE: This version of NCDB is version 2 and was updated on March 4, 2005 to reflect the update to 15 normalized variables in 2000.

Local users need to use the Remote Connection program to access the Neighborhood Change Database CD. To access that program a user will need to go the start menu and execute the following path (Programs-Accessories-Communications-Remote Desktop Connection). The Remote Connection program should be available on all PCs running Windows XP Professional. When specifying the connection, one can connect to either the NETBIOS name (RESEARCH2) or the IP Address (research2.psc.isr.umich.edu - 141.211.200.20). Note that NETBIOS addressing will only work for PCs in the PSC or ISR domain. Folks outside will have to use the IP or Internet Address).

Make sure to set the connectivity speed to LAN (or the highest speed one is using) - certain parts of the connection experience are turned off at lower connection speeds.

Note that the Remote Desktop connection will present the user with the Novell login client. The user will still need to log onto the PC with a valid username/password combination. Probably best to use the pscvisitor account if a user does not already have PSC or ISR account.

After successfully signed on to research2 a new window will open with a bar at the top showing the remote connection name. At this point you should see an icon on the desktop for the NCDB (Neighborhood Change Database). Double-clicking on the icon should start the CD.

Note: Due to licensing constraints and network capability, only one user can be referencing the RESEARCH2 workstation at one time. If the machine is being used you will have an error pop up informing you that the machine is currently active and unavailable.
GeoLytics®

IN ASSOCIATION WITH THE URBAN INSTITUTE

CensusCD® Neighborhood Change Database (NCDB) 1970-2000
US Census Tract Data

(Short Form Release)

USER GUIDE

Contents
A. Overview 2
B. Installation 3
C. Five Steps to Producing Files and Maps 4
  Step 1: Name Your File 4
  Step 2: Select the Year 4
  Step 3: Select the Area 5
  Step 4: Select Counts (Variables) 6
  Step 5: Run the Report (output data) 8
D. Using the Map Viewer 9
E. Notes About Race 11
F. Help 12
G. Contacting GeoLytics, Inc. 12

It is very important to enter this serial number exactly as shown, with no spaces or dashes, only numeric values. Do not use the serial number from another GeoLytics product, it may appear to install correctly, but won't produce accurate results.

Your Serial No. 3093212086853

GeoLytics® and the Urban Institute gratefully acknowledge the support of the Rockefeller Foundation, in the development and financing of CensusCD Neighborhood Change Database (NCDB) 1970-2000 Tract Data.

The source of the 1970-1990 data was from the Urban Institute’s Under Class Data Base. The data were weighted and converted to 2000 tracts by GeoLytics, who also created the 1970-2000 tract boundaries.
A. Overview

Neighborhood Change Database (NCDB)

The enclosed CD contains the CensusCD Neighborhood Change Database (NCDB) – 1970-2000 Tract Data, Short Form Release, developed by GeoLytics and The Urban Institute. Partially by the Rockefeller Foundation, the Neighborhood Change Database contains nation-wide tract-level data from the 1970, 1980, 1990 and 2000 decennial censuses, combined into one easy-to-use product. It is literally the only source of census data with variables and tract boundaries that are consistently defined across census years. It should prove an invaluable resource for policy makers, community organizations, and researchers who want to analyze changes that have occurred in U.S. neighborhoods over the past three decades.

Understanding how neighborhoods change over time is fundamental to addressing the problems and opportunities of America’s communities. Many people are not aware, however, that data obtainable from the U.S. Bureau of the Census cannot be used directly for these purposes, because of many changes in census tract boundaries and variable definitions between census years. In the early 1990s, with funding from the Rockefeller Foundation, the Urban Institute made adjustments as necessary to create the first national data file with consistently defined tract level census data for 1970, 1980 and 1990. That file has since been used as the basis for important research on how the nation’s communities changed over those decades.

Rockefeller has again provided funding to allow the Urban Institute to add 2000 census data to the file. To do so, the Institute has collaborated with GeoLytics, to not only add 2000 data but also to transform the product to make it much more user friendly and technically superior to the earlier version in a number of respects. GeoLytics applied their proprietary weighting tables for 1970, 1980, and 1990 to carefully convert past census data to new 2000 tract boundaries. This procedure allows NCDB data to be accurately compared over time for the exact same geographical boundaries.

NCDB data products are being released on CD-ROM using GeoLytics’ proprietary data compression and mapping technology. The data can be accessed using the menu-driven, mapping and analysis software included on the same CD-ROM, or the data can be extracted for use in external database, mapping, and analysis packages.

The NCDB will have two separate releases. The current Short Form Release includes Census 2000 “short form” data -- basic population and housing characteristics from the short form questions answered by all households in the decennial censuses. The NCDB Long Form Release (scheduled for 2003) will include responses to the Census 2000 “long form” questions that were asked of about one out of every six households in the census: detailed population, household, and housing characteristics, including income, poverty status, education level, employment, housing costs, immigration, and other variables.

For complete documentation on the NCDB, see the NCDB Data Users’ Guide. It is an extensive (700+ pages) guide that is on the CD (as a pdf) with detailed explanations on the history of the project, source of the data, methodology and terminology. This Guide includes a description of the remapping methodology used to normalize the 1970, 1980, and 1990 data to 2000 census tract boundaries, as well as a complete data dictionary listing all NCDB variables, their definitions, and sources.
B. Installation

1. Insert the CensusCD Neighborhood Change Database (NCDB) 1970-2000 US Census Tract Data into your CD-ROM drive. For the remainder of this manual the name will be simplified to CensusCD Neighborhood Change Database.

2. Click the Start button on the taskbar and choose Run from the Start menu.

3. Type D:/setup.exe (assuming D is the letter of your CD-ROM drive).

4. Click OK.

5. Follow the instructions on the screen.

Caution: If you want to assign the subdirectory path to something other than the default, the new path name must contain 8 or fewer characters and can't contain spaces.

Note: If you have previously installed CensusCD 40 Years, you will be prompted to uninstall it before continuing. Choose OK.

6. When prompted, enter your Name, the name of your Organization, and your Serial Number (found on the cover sheet of this manual as well as on your invoice). Type the serial number without spaces or dashes. It is very important that the number is entered exactly.

7. After the installation is complete, you can start CensusCD Neighborhood Change Database at any time by choosing Programs on the Start menu and selecting CensusCD NCDB.

Note: To operate the program, the original CD must be in the same CD-ROM drive from which the program was installed. Otherwise, the program will function, but you will receive errors when running reports.
C. Five Steps to Producing Files and Maps

The CensusCD Neighborhood Change Database includes powerful and easy-to-use software that allows you to specify the data and geographic areas you want to work with, and then create data files, charts, and maps from your specification. This can all be done by following five simple steps:

1. Name your File – this tells the computer where to store the report you are about to generate
2. Select the Census Year – data can be either in year-specific or normalized to 2000 boundary definitions
3. Select the Area from the pull-down menu (If you think of a map this will be the entire area covered)
4. Select the Counts (variables) that you want to see for these areas
5. Run the Report that you are interested in. Report formats are Summary, ASCII, dbf, or Maps

1. Name your File

![Image of Request File with options]

The default name given to the request and file is “Noname”. You can change the directory of the name by selecting Save Request As and then changing either the File and/or Subdirectory names.

**Caution:** names of the file and subdirectory must be **8 characters or SHORTER and cannot contain spaces.**

- **Open Request** Opens existing, saved requests
- **Save Request** Saves current request parameters giving it the same name and path
- **Save Request As** Used to start a new series of files and controls the path/name of subsequent files

**Note:** A request tells CensusCD Neighborhood Change Database the information you want and how you want it. The Request file stores information about the Year(s), Area and Counts, which is passed to the database to produce a file.

2. Select the Year

![Image of TractCD With Tract Options]

You can either access data for a specific Census year in the tract boundary definitions for that year, or you can access data for all four years normalized to 2000 tract boundaries.


The All years normalized to 2000 selection allows you to compare data for various years. The data for years 1970-1990 will be recalculated and normalized and the report will use the 2000 tract ID. For a fuller discussion of this methodology please refer to chapter 4 of the NCDB Data Users' Guide (on the disk as a pdf).

You cannot combine single year data (1970, 1980, 1990, or 2000) for two different Census time periods into one report because the tract boundary definitions change between Censuses. Therefore, comparing tract data across years can only be done using the data that have been normalized to 2000 tract definitions.

3. Select the Area
Select the geographic area you want. All of the data will be expressed at the tract level, but you select what area you are looking for coverage of. For a complete discussion of the areas included, please refer to chapter 2 of the NCDB Data Users' Guide (on the disk as a pdf). A pull-down menu will walk you through the specific selection. You can choose one of two area types: Geographic Area and Radius.

Geographic Area
In the Geographic Area window you can select the geographical area you want to use: Nation, State, Counties, and Tracts. The geographies of MSA/CMSA and PMSA are only available for 2000 boundaries (including All Years).

Searching for a Geographic Area
You can search for any area that contains a specific word or character string by clicking the Search button. Type a word to search for and click Go. The search engine will tell you how many records were found that match. Click on DONE to accept the selections. Then select ADD to add them to the request.

Radius
The second type of area is Radius (circular ring area). You may decide to use this type of area view to get information around a specific location. Use an exact Latitude and Longitude to specify the center of the Radius. Then, enter the distance from the center of the radius to specify the radial area size (for example, 20 miles from a specific location).

The report will cover the selected areas. Depending on the report type, it will render a summary of the data for these areas or it will be broken down by Census Tracts.

Note: The source data for the 1970 and 1980 NCDB variables are the original tract-level data provided by the census, which did not cover the entire United States. Thus, when mapping the 1970 or 1980 data you will see holes in the US. Since the tract-level data did not exist for 1970 and 1980 it therefore will not be available in the Normalized boundaries. In some cases, part of the area in the Normalized data boundaries will have been
tracted in 1970 or 1980 but not all of the area. The user can identify these situations when using the Normalized data by examining variables PCTCOV70 or PCTCOV80, which indicate the percentage of 2000 census blocks that were covered by 1970 and 1980 tracts, respectively. For more information, please refer to chapter 4 of the NCDB Data Users’ Guide on the disk.

4. Selecting Counts (Variables)

Below is the Counts screen. To make a selection you can either use a Search for the count (or category of counts) OR you can scroll through the list of variables and Select the individual variables you want.

The Variables are all identified with the following characteristics:
Name (B) - this is a 5-8 character name, the number (7, 8, 9, 0) at the last (or second to last) character relates to the year. It will be used as the heading for output file reports.
Year (C) – this is particularly useful when using the normalized data, it insures that you are selecting the variables from the appropriate census year.
Description (E) – this is a descriptive definition of the variable. This information will also be exported to the “myfile.doc” output file. And is very useful for identifying which variable is which.

Search

You can enter your own variable into the Search window (A) and then hit the Search Counts button (J).

Alternatively we have provided a long list of “Key Words” (G) that can be searched. Use the pull-down menu to find the key word(s) you want and then hit the Paste (H) to get the key word to appear in the Search window (A). Then hit Search Counts (J).

The Counts that are available (D) will be searched and those that meet the criteria will be tagged. The Found (I) indicates how many variables met your criteria.
Once you have done the Search you can Browse the counts that met your criteria by clicking on (M) Browse Last Search Results. This can be helpful when you are trying to figure out which 929 variables of the 2867 were selected. Each time you hit this button it will take you to the next count that met your criteria (if they are all in a row it may not feel like it is moving, but it is). To unselect all of the current selections, click on any other variable. To unselect just one of the variables, hold down the CTRL key and click on the variable to be unselected. When you have the counts that you want, click on the (N) Add Selected Counts to Report. Then all of the counts that you have selected will be transferred to the lower screen and will now show up in your output file.

**Manual Selections**

By scrolling through the variables that are written out in the middle section, you can identify those of interest by their Name (B) or the Description (E). The Year column (C) is important when using the Normalized data so that you can distinguish the same variable from multiple years.

To select a variable click on it (it will be highlighted in blue). To select additional variables use a Ctrl + Click (to select one at a time) or Shift + Click to select all of the variables between as well.
When you have the counts that you want, click on the (N) Add Selected Counts to Report. Then all of the counts that you have selected will be transferred to the lower screen and will now show up in your output file. The maximum number of counts that can be exported at one time is 240.

Bottom Screen – (heading Report Counts F)

To Drop Variables from the Report Counts:
You can review the counts selected and highlight some of the variables to delete with the “Drop Selected Report Counts” button (P). If you press (O) you will clear the whole report and can then start over.

To Add Additional Variables:
You can manually select them from the Counts screen (middle screen) and then hit “Add Selected Counts to Report” button (N).

For more information about the counts please refer to chapter 3 of the NCDB Data Users’ Guide on the disk (as a pdf). A complete list of counts with definitions and sources can be found in appendix E.

5. Run the Report in the Format You Select
Go to “Run”, select Summary, dbf, ASCII, or Maps.

Summary – a sum for the area (without listing subarea numbers) for the counts selected
Dbf – a dBase-compatible data file with a .dbf extension easily imported into statistical and spreadsheet packages.
ASCII – available in tab or comma delimited format with headers. File will have a .txt or .csv extension and can be easily imported into statistical and spreadsheet packages.
Map – the polygons can be exported as either shape or mid/mif files and will have an accompanying .dbf file with the data. You can import these files into ArcView, MapInfo and other mapping software packages.

Your output file can be found under the subdirectory and file name that you selected when you named the request file. If you didn’t save the request file then your output file will be found under the subdirectory you installed the Neighborhood Change Database on with the name “noname”. In addition to the output file you installed the Neighborhood Change Database on with the name “noname”. In addition to the output file you installed the Neighborhood Change Database on with the name “noname”. In addition to the output file you installed the Neighborhood Change Database on with the name “noname”. In addition to the output file you installed the Neighborhood Change Database on with the name “noname”.

©2002 GeoLytics, Inc., E. Brunswick, NJ. All rights reserved. Current as of August 2002
The file run is done in a multitasking mode so that you can go on selecting other files or doing other tasks while the system continues to access the database for the information you requested. When the file is completed, a viewer/map window will be created and activated, and the completed file will be displayed or mapped.

![Image of TractCD Report Generator](image)

### Saving your data

SAVING your report – this is automatically done; your output file can be found under the subdirectory and file name that you selected when you named the request file. If you didn’t save the request file then your output file will be found under the subdirectory you installed the Neighborhood Change Database on with the name “noname”. In addition to the output file you requested, there will also be a .doc file (with the same name as your report) that will have the full names of each of the variables and geographies that you selected for your report. This is very helpful when labeling spreadsheet columns.

You can view any file using the **CensusCD Neighborhood Change Database** Report Viewer. While browsing the file, you can search for information, copy to clipboard, or print the file.

### D. Using the Map Viewer

Within the Map Viewer you can change data themes, ranges, and color schemes. It allows you to print your map with options to save it as a bitmap (.bmp) file, which can be imported or pasted into most word processing, spreadsheet, and graphics packages. **CensusCD Neighborhood Change Database** also lets you export boundaries and data in desktop mapping formats (ArcView or MapInfo). There is even a variable calculator for creating and displaying virtual variables based on data in your file.

Generating the map automatically generates a dBase file, which can be used with other software, including statistical (e.g. SAS, SPSS), database (e.g. Access, Oracle) and spreadsheet (e.g. Excel, 1-2-3) packages. You can also export the boundary files (under the File menu) for use in mapping (e.g. Arc View, MapInfo) software.

A specific help section to explain the map viewer is available from both the main help contents and the Map Viewer itself.
Below is the labeling for each of the selections that you can make from the Map Viewer screen.

To the side of the map viewer are tabs that you can use to alter the way the data is presented.

**Area** – Lists each area that is mapped

**Record** – Lists the counts in the file, change the one being mapped by clicking on a new count

**Legend** – Choose the ranges and colors for your map, also shows mean, median and standard deviation

**Layers** – Control border thickness & color, add labels, you can also add an internal or external boundary map

**Log** - Records what has been mapped.
HINT: You can even use the Map Viewer to display your own .DBF data files if you have a key column which lets the program match boundaries to your data records. You can also add on your own ArcView boundary files (like neighborhood boundaries or a nonprofit location). See the Map Guide under the Help menu for more information on how to display your own files.

E. Notes about Race

The list below shows the racial choices that were allowed for each Census:
1970 – White and Black
1980 - White, Black, American Indian, and Asian
1990 - White, Black, American Indian, Asian/Pacific Islander, and Other

The choices for 2000 are much more complicated; we have included three different options:
Min - Census Bureau’s definition using single race only
Max – Census Bureau’s definition using race alone or in combination
Total (SHR) – Urban Institute’s definition using bridging methodology described below.

From the Census Bureau
Because individuals could report only one race in 1990 [and every previous census] and could report more than one race in 2000, and because of other changes in the census questionnaire, the race data for 1990 and 2000 are not directly comparable. Thus the difference in population by race between 1990 and 2000 is due both to these changes in the census questionnaire and to real changes in the population.


From the Urban Institute
A major change in Census 2000 from previous censuses was the addition of multiracial categories in the collection and tabulation of the data. Respondents in Census 2000 were allowed to select one or more of six racial groups: White, Black/African American, Native American/Alaskan Native, Asian, Native Hawaiian/Other Pacific Islander, and some other race. In previous censuses, respondents could choose only one racial group. Only about 2.4 percent of respondents nationwide selected more than one racial group in Census 2000, although this proportion was much higher in certain census tracts.

In tabulating population by race for Census 2000, the Census Bureau provided counts for all 63 combinations of the six racial groups that a respondent could have selected. To facilitate comparisons with previous censuses, the “race bridging” variables in the Neighborhood Change Database take all of the multiracial categories for Census 2000 and reapporportion them into single racial groups. This allows one to compare racial change for tracts between 1970, 1980, 1990 and 2000 censuses. There are many possible methods for creating bridging variables. The method we selected was developed by Jeffrey Passel of the Urban Institute’s Population Studies Center. It assigns multiracial groups to single races according to the rules below, in descending order of priority:

1. Black + any other race ➔ Black
2. Asian + any other race ➔ Asian
3. Native Hawaiian/Other Pacific Islander (NH/OPI) + any other race ➔ NH/OPI
4. Black + any other race ➔ White
5. American Indian/Alaskan Native + any other race ➔ AI/AN

For the sixth group, “Some other race”, only people selecting this alone are assigned to that bridging category.

For more information about racial classifications and variables please refer to chapter 4 of the NCDB Data Users’ Guide on the disk (as a pdf).

F. Help

CensusCD Neighborhood Change Database contains extensive on-line help. Help contents contain thousands of lines of on-line searchable help. The online help can be accessed through the Help menu of the main program, the Report Viewer, or the Map Viewer.

When you click on Help you will have the option of seeing the information listed in this Users Guide, the License Agreement and many other features. If you click on the Index choice along the top bar you can key any word or phrase into the screen (or just scroll through the alphabetical listing) to learn more about hundreds of subjects and variables. There is also an entire section dedicated to the Map Viewer to help you get the most from this very powerful tool.

There is also “automatic advice” located on the bottom of the screen. For “next step” prompting it is written in blue along the bottom bar.

Further documentation of the NCDB data, including counts, geographies, changes in definitions over time, and weighting methodology, can be found in the 700+ page NCDB Data Users’ Guide on the CD in pdf format.

G. Contacting GeoLytics, Inc.

GeoLytics makes itself accessible to customers in various ways, with each medium playing a specific role. Our support e-mail address caters to those who have technical questions about the product or are seeking information about the data or how to use the product. Please, do not call the 800-number for tech support. The 800-number should only be used when installing product for the first time and for sales purposes.

Tech Support: support@GeoLytics.com
732-651-2000


Fax: 1-732-651-2721

Web Site: http://www.Geolytics.com

Mail: GeoLytics, Inc.
PO Box 10
East Brunswick, NJ 08816
Dear NCDB Purchaser,

Thank you for your patience. Enclosed is your copy of the Long Form version of the Neighborhood Change Database (NCDB) by GeoLytics® Inc., in association with the Urban Institute. The updated Neighborhood Change Database expands on the earlier version by adding nearly 2,500 new variables. The NCDB upgrade has about 1,800 variables from the 2000 Census Long Form, previously unreleased on the earlier Short Form version of the NCDB. In addition, we have added 350 new variables from the 1990 Census, nearly 250 new variables from the 1980 Census, and almost 100 variables from 1970 Census.

Now that you have the new version of the NCDB, you must email Geolytics at SERIALS@geolytics.com to receive your serial number.

Also included in the new edition are fixes for errors in the previous edition of the NCDB. Now that the updated NCDB Long Form version has been released, we will no longer be supporting the earlier versions of the program.

To use the updated NCDB, you must uninstall the Short Form version and install the new Long Form Version with the serial number we email you. Discard the old CD immediately after you load the new version of the NCDB. Of course, we will continue to offer our outstanding customer support service for the new updated NCDB Long Form version.

When installing the NCDB no part of the path name can exceed 8 characters. We recommend that you use the default path when installing the CD. However, if you choose to reassign the path, no part of that path can exceed 8 characters. To use the program, the original CD must be in the same CD drive in which it was installed at all times. Otherwise the program starts, but you will not be able to run reports.

1. Insert the NCDB disk into your CD drive

2. You can install the disk through the Windows Program Manager or “My Computer” icon
   a. In the Windows Program Manager, choose “Run” from the “Start” menu
   b. Type in D:\set.exe (assuming D is the letter of your CD drive), click OK
   OR
   a. Click on the “My Computer” icon and choose the CD drive (often D:\)
   b. Click on the “Set Up” icon (it looks like a small blue computer)

3. Follow the on-screen instructions. Note: if you have previously installed the NCDB, you must uninstall it now. The software will prompt you through the uninstall process.
4. When prompted, enter your name, the name of your organization, and your serial number, which you can get by emailing GeoLytics as SERIALS@geolytics.com. Type the serial number with no spaces or dashes. It is very important that the number is exact.

5. After the installation is complete, you can start the product at any time by double-clicking on the corresponding NCDB icon or from the Windows “Start” button.

After installing your new NCDB, you can run the program much like your previous version. Just select a data format and year, then select your geography, and finally pick the counts (variables) that you want to explore. Now you are ready to run your report, including dbf files, ASCII files, maps, and summary reports.

If you have misplaced your user guide, a copy of the full user guide along with hundreds and hundreds of pages of documentation can be found on the subdirectory “Data Users’ Guide” on your new NCDB.

If you want more information on the upgrade or any of our other products, please visit our website at www.geolytics.com or call us at 732-651-2000.

Thank you,

Katia Segre Cohen
Marketing Director
GeoLytics, Inc.